COMPSCI 111 /111G

Mastering Cyberspace:
An introduction to practical computing

Word Processing

Learning Outcomes

Students should be able to:
» State what ASCII stands for
+ Explain why ASCII is important
+ Use ASCII to encode or decode text

+ Explain the main differences between a text editor and a word
processor

+ Distinguish between surface and structural formatting
+ Describe the advantages of structural formatting
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ASCII

American Standard Code for Information Interchange.
» Code used to represent English characters as numbers
* There are 127 characters
+ Codes for A-Z, a-z and 0-9 are contiguous
Some of the ASCII codes

Exercise

A 65 | 73 Q 81
B 66 J 74 R 82
C 67 K 75 S 83
D 68 L 76 T 84
E 69 M 77 U 85
F 70 N 78 vV 86
G 71 o 79 w 87
H 72 P 80 X 88
http://len.wikipedia.org/wiki/ASCII
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Given that the number 32 represents a space in ASCII,
what is the following sentence in ASCII?

707988327378328379677583

Encode the first name of the person sitting next to you
using ASCII codes.

1/08/2007 COMPSCI 111/111G - Lecture 08 4




Text Editor

Text Editor
» Allows user to edit the characters on the page
+ Plain text (ASCII)
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http://len.wikipedia.org/wiki/Text_editor

Word Processors

1/08/2007 COMPSCI 111/111G - Lecture 08 5

Word Processor
» Extension of a text editor
» Allow user to format the document (change the appearance of text)

Fonts
+ Style, size, typeface

Paragraph

» Alignment, spacing

Document
* Margins, Headers, Footers

http://en.wikipedia.org/wiki/Word_processor
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Standards

Each word processor decides how to store information

+ Uses special codes to identify the format of the text
— Bold, italic
— Font size
— Alignment

+ File is saved with these codes

Standards
» Proprietary (MS-Word)
* Open standard (Open Office)

What you see is what you get
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WYSIWYG (Whizzy-wig)
» Graphical User Interface
* What the user sees is the same as the output printed

Most modern word processors work this way
* Microsoft Word
* Open Office
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1/08/2007 COMPSCI 111/111G - Lecture 08 8




Postscript printers

Postscript
» Language used by Laser Printers
+ Tells the printer how and where to display text
» Created in 1985
+ Started Desktop Publishing revolution
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Using Microsoft Word
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Page Layout
* Make sure that you are creating an A4 page
+ Page Setup from the File menu

Different views
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Setting Preferences

Tools — Options CIrE— 21
Track Changes | User Information |  Compatibiity | Fils Locations |
view | General | Edt | Pt | Save | Speling & Grammar

Page Layout view options

Automated Features show
IV Drawings: [¥ iighlight:

[ object anchors ™ Bockmarks

° AUtO Save ™ Text boundaries I Eield codes
[ Picturs placsholders Figld shading:

e Auto Format % Animated best [ihen sekecied =]
¥ screenTips

» Auto Spelling correction  termmm e
™ Tab characters I optional hyphens

. . [~ spaces ™ Hidden text
* Non-printing characters  rreammse " a
indow
[v status bar [V Horigantal scroll bar
¥ vertical ruler [V wertical scroll bar
This text has tabs+ - and spacesd
H OF, [ |
Notice the marker used for the paragraphs [ =
T
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Basic Features of a Word Processor

Editing Text
* Word Wrap

Insert Point/ Cursor:
* Insert/ Delete . . \
+ Select Text for action Hellgj
T
Clipboard
» Keeps one clipping
+ Cut, Copy, Paste yyyy
yyyy
Formatting 7 QA
» Character XXXXXXX  Cut Paste XXXXXXX
+ Paragraph -// XQ XXXXXXX
+ Document -
XXXXXXX
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Find and Replace

Useful for repetitive changes

Fid | Replsce | GoTo |

=7 | Find Next

Find what: I =l
Cancel
Replace with: | >|  Replace

Spelling and Grammar

Check as you type
» Spelling
* Grammar

AutoCorract | AutoFarmat As You Type | AutoText | AutoFormat |

[¥ Correct Two Initial CApitals Exceptions. ..

™ Capitalize first lstter of sentences

Some wyropds in this gentense are spelt wiong. ¥ Capitalize pames of days

[¥ Correct accidental usage of cAPS LOCK key

2

¥ Replace text as you type

Replace &l
. . Replace: with: % Flsin text & Formatted bext
Search: Al = ™ Match case Less % £ opds inthis sentence are spelt wrong. |tre [Hehe... the phantom strikss again]
I~ Find whole words only
B ot Frocampany | e campary El
I Find all vaord Forns thefirst EIELIES
- LS thegavernment | the government
e their are there are
Mo Formatting | Farmat ~ | Special ™ their is o2 o
themselF themselves
themselfs themselves |
Auto Correct cokte
+ Common misspelling
O Cancel
+ Abbreviations
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Formatting Font
] 3 iz - Horrmal v Ti -1z - B I U
Toolbar v - 2 Toolbar ™ e =
ront 21x
Fgrmi;ntlw\s Table  window  Hel Dialog Box (from Format me = |cha;acter5pacing | animation |
Eont... Font Font skyle: Sizes
Paragraph. .. [requisr [10
Bullets and Humbering...
Borders and Shading. .
Appearance of Text
Tabs... . Typeface Underline: Color:
. I(nune) =] IiAutu =]
it + Style (Bold, ltalic) Effacts
. i . . I strikethrough I~ shadow I small caps
hange Case. . + Size (in points) ll:uuum_e strikethrough ::Qutlme ::&\ caps
Superseript Emboss Hidden
Badground ' . I™ subscript I” Enarave
olour
g Theme.. Provisw
Frames 8 + Effects
3
A AutoFormat... 1995
44 Styles and Formatting. ..
£, Reveal Formatting...  Shift-+F1 =
3 Spacing R TRty o T e e
* Kerning Defautt.. T
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Paragraph

Dialog Box (from Format menu)

Paragraph

2]

Indents and Spacing | Line and Page Breaks

At [T

Qutline level: Body text

Indentation

Appearance of Paragraph

Special: Ey;

I(none) j | ﬂ

Line spacing:  Ak:

i Left: 0cm
) Allgnment Right: [oasm =
+ Spacing s
* Indent Befare: 0 pt E
After: Jopt =
Preview

ISiane Bl =

0 ras s e Bt gromeg e 1k Lo 1t

Tabs...

Cancel

Indenting Paragraphs
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Hanging Indent

A word processor allows wou to create, wiew, edit, format, print and store text. Most modern
word processors have many advanced and Microsoft Word is no exception
Some of these features are incredibly useful, while others are not. We wil look at
some of the mere commeon features here.

First Line Indent

<‘ A word processor allows you to create, view, edit, format, print and store text.

Most modern word processers have many advanced and Micreseoft Word is ne exception.
Some of these features are mncredibly usefil, while others are not. We will look at some of the
more commeon features here
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Format Document

File Menu — Page Setup
* Margins
» Paper size, orientation

Margins | Paper aper Source | Layout |

Borders and Shading

Paper size: Previ

| — Apply to whole document

Width: 2tem =

\

Height: [eorem =

rigntation

 Partralt

€ Landscape

Apply ko |whole document -

pefak.. cancel
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Applies to either:
» Paragraph
* Whole Document

?| eage Border | Shedina |

21

Setting: Style: Frevisw

El - Click on diagram below or uss
buttans b Iy bord
D - uttons to apply borders

hpt ———— w| | Applyto:
§ Custom

& = IParaqraph |

Options...
Show Toolbar Cancel
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Columns

Set the number of columns

cancel |

c- I 111}

g
=
e
3
%

Murmber of columns: E‘ I Line betwesn

rWidth and spacing

’_ =
’7 lﬂ. lﬁ
¥ Equal column width

apply to: |whu\e document - I start new column

JOUL

Using Breaks
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Page Breaks

Breake 2lx
+ Forces a new page to start -

reak, " golumn break
Section breaks

" Mext page " Even page
" Continuats  0dd page
Column break
- Forces a new column to start [ o ]_cm |
Section Break
» Forces a new section to start
* New section startson ~ _
— Ssame page Fage Break
— next page

next odd page
— next even page
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Header and Footer

Add content to top/ bottom of every page

Toolbar used to add Page Numbers, Current Date etc.

Header and Footer

Insert AutoText + A H B 08 E T 5 dese

Note: Must be in Print Layout view to see Header/
Footer

Footnote/ Endnote

1/08/2007 COMPSCI 111/111G - Lecture 08 23

References

+ At bottom of page (Footnote)
+ At end of document (Endnote)

Footnote and Endnote

21

Bottom of page

¢ Endnote End of document
Numbering

" putohumber 1,23 .

" Custom mark:

Symhol..
ok | cancel | options.. |
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Styles

Applying a style

Surface/ Physical

Style sheet accessed via the toolbar..

( — i Morrnal = -
+ Make changes directly A E| caption o
. i Arial, bold, 16 pt~T—— [ : =
e.g. Arial, 24 pt, bold, centered A::I’ “:"c' 12':{,.:. To apply a style Heading 1 L o
Arial, bold, 16 pt~T——— + Select text Heading 2 Tom
. » Choose style from drop down menu Heading 3 S
Structural/ Logical —
Assign a style to each block of text —
ssign a s yle o.eac ock o e>$ Advantages Lecture Notes Subheaing EIL
+ e.g. Heading1, Fish Names, Captions Aool o . pre = 1
) » Apply many changes at once 12 pt
+ Define how the style looks (Style sheet =
y (Sty ) + Consistency Body Text T2 ot
Heading1 ~[——— Style Sheet + Easy to alter style Bt G=h B is .
St (el := Heading 1: Arial, bold, 16 pt Bod et om
Subheading Section Heading: Arial, bold, 16 pt Detnals B Fon = a
Heading1 ~[—— Subheading: Arial, italic, 14 pt e
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Creating/ Modifying a style Formatting a Style
Choose Styles and Formatting from the Format menu Choose Paragraph or Character style type
* Click on New Style
- n —
ET I RENE-4 oo ‘: :“:‘lw1 I::\:‘l’:;:“ ﬂ: dem!" . . x|
. IR b Specify the formatting you want =
i—h'- T e et o . Font Sty e EE—
. ! g o sebeted et . Styls based on: ol Heading 1 -
: i Headgg 1 Paragraph Style for following paragraph: 1l Stylel -
Skt 4 | | b Sty * Border Formatting = 5 | r |
ek Formattong Lo apply Arial |6 +[iB £ U |A-
: = 2 Tabs Ez==(--|=zs|x=
i J + Numbering
i Ht:a!::ling1 :
: e Heading 2 '
& | e — .| Heading 3 ' Heading 1 +
-'_”:I quw S—— | :...‘ :i::J], I~ add to template I~ Automatically update
Pe 3 Se? W Mism w2 cds [ 4 Format + Cancel
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Exercises

Give an example of formatting that is structural.
Give an example of formatting that is surface.
State one advantage of structural formatting.

State one advantage of a user-defined style in MS-
Word.

EndNote
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Bibliographic Database
* Maintain database of references
+ Add citations to documents
+ Consistent referencing / bibliographic information

Advantages
+ Consistency
+ References are stored electronically
+ Easy to alter formatting for different publishers / subjects
+ Good once you learn

» University of Auckland has site license
— Free for students to use at home
— Courses on EndNote from Student Learning Centre

Disadvantages
* Not easy to learn

1/08/2007 COMPSCI 111/111G - Lecture 08 30

Getting Started

Create a new EndNote library
* Used to store references

EndNote 7 x|

Get started with EndNote 7

% Create a new Endhots library
.

IE € See whal's new in EndNole 7

é " Dpen an existing EndNate lbrary:
I =] Brose

I Do ot display this message again

Cancel

An empty library

1/08/2007 COMPSCI 111/111G - Lecture 08 31

=100

File Edit References Tools ‘Window Help

DG i i@ nm| | E o |amte Ellnz|
[Pizin Font H[Panses =] B2 WP | A" A E |

=T
B [ Author [ ear [Tite

< | |

Showing 0 out of O references. | ¥ showpreview
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Adding a new reference manually

Choose References — New Reference

» Select the type of reference (Journal article, Book, etc.)

» Enter the data into the appropriate fields

Importing a reference

Find the article in an online library
» Get the EndNote citation (often provided)
+ Save it to the disk as "Plain Text"
* Choose File — Import

FTES  Select the file, and choose "EndNote Import"
ﬂ z! Releience Type: [Jocmal Aticle - |
= EOSETSTEI T T alnix
uthos: S o e Hiwdas s ©)* st D i Ches_snd_backgammen_retesence | Chora Fie_ |
5. & L F ey rse—— 54 o
i P i Ty frse———— e ot [Erebicas brgeat =
[ © PORTAL [ b I -
Joumat: 7 [ : Teot Tianalitior: Mo Tvarulatons =
e THEACK BT URARY i —
lsve: Chess and backgammen
oo bl
Date:
Short Title: Tosh and Actisns
Allurnaty Journal )| o I ,uﬂ
0 e [ } et ) Frdlrs | ighiate gl [ Manghsase
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Connecting to online libraries Connecting to online libraries (2)
Search online libraries directly + Select the entries you require
+ References are imported into the EndNote database . "Copy References to EndNote"
* Voyager uses this system » Entries are added to the database
llEndvote 7gpiday =lolx]
e Tools — Connect — Voyager Fle Edt References Taols window Help
D&t medis @858 0| E D[t =linz |
[Plein Fort ZlPense="=]|B 2 uw B [A" A = |
[#) Connected to: University of Auckland Library Catalog at Universits =0l x|
[Done Copy 7 References To= -
Author |Year |T\t\e
Barrio 2005 Current topics in physics . in honor of Sir Roger J. Elliott
) 5 f 05 g lies : the mathematics o )
cial history ; Games in the eighteenth
i olo
e Carot Conrwet
& L
Fietame _oopageina
Crewed Timeday Massh 14 206 329 PM
Mo Woedrwoclay Jarary I, 004, 2 13 FW 0
Baed O Huygens
Ty
gl | |
[showing 10 out of 10 retrieved references [ ¥ showPreview g
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Using the citations

Using the citations (2)

Start a MS-Word document

+ Click cursor at the point to enter a citation
+ Select “Find Citation” from toolbar

"

Ethh B g 18| B 7 E

Alternate method
» Start Endnote
» Select one of the citations
+ Start the Word document
* Choose Insert Selected Citations

ssefaBisdednat

==

o
* Computer Backgammes

or
* Tools — EndNote — Find Citation
» Select the reference and click Insert
(o L 151 1
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Finalizing the document

Once all citations are complete
» Choose Format Bibliography
» Updates all the Citations
* Uses the style selected

Output Styles

» Defined for all major publishers

Falkener. E. (1961). Games ancient and
oriental. and how to play them:
being the games of the ancient
Egyvptians. the hiera gramme of the
Greeks, the ludus latminculorum of
the Romans, and the oriental games
of chess, draughts, backgammon,
and magic squares. New York,
Dover Publications.

Hans. B. (1980). "Backgammon program
beats world champ." SIGART
Bull (69): 6-9.
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games of the ancient Egyptians, the hiera
gramme of the Greeks, the Judus
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York,; Dover Publications.
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York,; Dover Publications. 366.
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1980(69): p. 6-9.
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